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What cyberinfrastructure is required to measure, model, analyze, and communicate scholarly
data and ultimately scientific progress?

This talk presents our efforts to create a science of science cyberinfrastructure that supports:

Data access and federation via the Scholarly Database, http://sdb.slis.indiana.edu,

Data preprocessing, modeling, analysis, and visualization using plug-and-play

cyberinfrastructures such as the Network Workbench, http://nwb.slis.indiana.edu, and

Communication of science to a general audience via the Mapping Science Exhibit at
http://scimaps.org.

This talk should be particulatly interesting for those interested to
Map their very own domain of research,
Test and compare data federation, mining, visualization algorithms on large scale datasets,
Use advanced network science algorithms in their own research.




Scholarly Database
http:/ /sdb.slis.indiana.edu

“From Data Silos to Wind Chimes”

Scholarly Enowledge o

Figure 1: The interoperability }
€@, papers, patents, grants, are stored and made available so that ‘vertical’ citafion lnkages can be
traversad. Thers are very fow mstancas in which datassrs of different origin and or rype are ‘horzantally
mterhnked

and crows linkage problem. Many bt not all of today's scholarly datasets

» Create public databases that any scholar can use. Share the burden of data cleaning and
federation.

» Intetlink creators, data, software/tools, publications, patents, funding, etc.

La Rowe, Gavin, Ambre, Sumeet, Burgoon, John, Ke, Weimao and Birner, Katy. (2007) The Scholarly Database and Its Utility for
Scientometrics Research. In Proceedings of the 111h International Conference on Scientometrics and Informetrics, Madrid, Spain, June 25-
27,2007, pp. 457-462. htep:/ [ ella.slis.indiana.edu/ ~katy/ paper/ 07-issi-sdb.pdf

Scholarly Database: # Records & Years Covered

Datasets available via the Scholarly Database (* internally)

Dataset # Records Years Covered Updated Restricted
Access

Medline 17,764,826 1898-2008 Yes

PhysRev 398,005 1893-2006 Yes

PNAS 16,167 1997-2002 Yes

JCR 59,078 | 1974, 1979, 1984, 1989 Yes
1994-2004

USPTO 3,710,952 1976-2008 Yes*

NSF 174,835 1985-2002 Yes*

NIH 1,043,804 1961-2002 Yes*

Total 23,167,642 1893-2006 4 3

Aim for comprehensive time, geospatial, and topic coverage.




Scholarly Database: Web Interface

Anybody can register for free to search the about 23 million records and
download results as data dumps.

Currently the system has over 120 registered users from academia,
industry, and government from over 60 institutions and four continents.

¥ Scholarly Database :: Search - Mozilla Firefox ¥ Scholarly Database = Results - Mozilla Firefox o [=]
File Edit View History Bookmarks Tools Help Elle  Edt iew Higtory Bookmarks Tools  Help

C 0 o [0 [httpsyisah sis. ndiena.edujsearch 7 C 0w [0 T hpsob sis.ing ‘ q={"artfcial inteligence) 1.7 - |[Gl+| mark mckie umich J~'
|.8] Most visited 4 Getting Started 5. | Latest Headines | | Hatel Kénigshof - Bod 2] Most visited 4P Getting Started 5. | Latest Headlines | | Hatel Kznigshaf - Bad

SCHOI ARIY DAT/. %»? CCHO! ARIY DATARACQE
ey

S
&G L‘f Cyberinfrastructure for Network Science Center, SLIS, Indiana University, Bloomington

Cyberinfrastructure for Network Science Center, SLIS, Indiana Uni

Search | Edit Proﬁ\e% Adrnin% About Logout% Search% Edit Profile | Admin About% Logout

If multiple terms are entered
Search automnstically earmbined using Browse Results

cancer’ matches any recard il

Creators: l— that fisld -
I Yeu can put AND betwaen tern Your search returned 13,231 results in 0,295 seconds,
Title: *AND’, Thus ‘breast AND cance LN
racords that contain both term g
Abstract: Total rezults per database: NIH: 2,103, Medlina: 10,235, USPTO: 279, NSF: 614.

Double quatstion can be used

All Text:  ["artificial intelligence” terms, e.g., “breast cancer™ 1

the phrase "brasst cancer’, ar

First vear: [1955 ] torecatand cancer e bt Results 1 through 20,
Next>>
Last Year: |2008 » The importance of a particular
incraszed by putting a ~ snd Score (out of

B oo term. For instance, ‘breast car Source  Authors/Creators Year Tide 5.71)

Hedline (1865 - 2008) the impertance of matching th
W IH (2961 - 2002) compared to matching the ter Medline Lacombe 1987 Artificial intelligence. 571
' sk (1985 - zo04) Medline 1989 Artificial intelligence: expert systems. 571

C )

¥ uspto (1076 - 2008) Medline Schmitt 1330 [Artificial intelligence in dentistry] 5,71

Madiine 493550 2nd 2002 Artificial-intelligence -augmented systems. 560
Adlassnig

¥ scholarly Database :: Downloa

o:

efox —|of x|

Fle Edit View Hstory Bookmarks Tools  Help

@ = € 0 o |1 [epyrsdb sis.indisna.edudonnland/zq={ artfical inteligence) AND 77~
(5] Most Visted @ Getting Starbed . Latest Headlines | | Hotel Kénigshof - Bod. SlnCC March 2009:

SCHOI ARIY DATARASF 7| Users can download networks:

- Co-author

- mark mekie umich -

Cyberinfrastructure for Network Science Center, SLIS, Indiana University, Bloomington

- Co-investigator

Search | Edit Profile  Admin  About | Logout |

- Co-inventor
- Patent citation

Download Results

Download [20000 records starting at record |1 from the fallowing databases: and tables for burSt analySIS
I select all dovnloads. ln NWB.

Medline Database: =

- I=E
Madling M2SH hading table Fle Edt ¥ew Favorites Tools Help ‘ ar
7 Mediine MeSH qualifier table [0 —
I Wediine suthar table [T @ Back - Q - ) Smarch i Folders
I Wediine ca-author table (nub formaty 11 -
™ Mediine master table [1] Address [ D:\sampledatatstientometricsisda BECE
2| Hame | skl
NIH Database: CD Writing Tasks ¥ Files Currently on the CD
I Mtk rmaster table T8
a il L5V 960 KE
File and Folder Tasks = @ EINE AL A0l Y
NSF Database: Bl Medline_co-author_table_{rwb_format}.csv 627 KB
) Make aniew Folder EllMedine_master_table,csv 13,986...
7 MsF casinvestigator table(nub farmat) m e Publish this Folder ta the @MEd\lnaiMESHihEadmgitah\a‘Esv 3,453 KB
7 MsF master table [ b @Med\ine_MeSH_quaIiﬁer_tab\e‘csv 853 KB
n
USPTO Database ELIMIH_master_table.csv 5,189 KB
Other Places a %1NSF_co-invastigator_table_(nwb_Format).csv 19KEB
I USPTO Patent Casparation Treaty table [0 ELYSF rmaster_table.csv 1,303K8
7 USPTO agent table = I3 scentometrics B USPTO_ co-inventor_table_{rwb_format).csv 18KB
T UsPTo assignes table [0 My Documents EL)USPTO_agent_table.csv 20KE
7 UsPTo citation table (rub farmat) m \g My Metwork Places ELUSPTO_assignes_table.csv 23KB
I UsPTO caims table [ ELJUSPTO_citation_table_{nwh_format).csv 72KB
[T UsPTO cosinventor table (nub formaty [T EHUsPTO_inventor_table.csv 69KE
; USPTO inventor table o Details = ELlusPTO master_(burst_Formak).csv 308 KB
- USPTC master (burst format) sdb BEL)UsPTO_master_table.csv 37KB
UEPTO msster table File Folder I EJuspTO_patent_Cooperation_Treaty_table.csv ZKE
Date Modified: Today, April
Download | 0, 2009, 1:25 PM 4] | i

[ Done




Scientometrics Filling of Network Workbench Tool
will ultimately be ‘packaged’ as a SciPolicy’ togl

Downloads for NWB Tool Releases

http://nwb.slis.indiana.edu

The Network Workbench (NWB) tool
supports researchers, educators, and
practitioners interested in the study of
biomedical, social and behavioral
science, physics, and other networks.

In Feb. 2009, the tool provides more 100
. . summary ) . )
plugins that support the preprocessing, Taolot for Bomedic, Socil Sciece and Phy]

evaluate, and Operate a unigue distributed, sh:

analyslS, modehng’ and Visuahzatlon Of large-scale network anatysis, madeling, and v

(MwD). The envisioned data-code-computng 1|

20,000

Cumulative Total

15,000

10,000

Number of Downloads per Month

5,000

networks. Hoow o cite i project

Hews & Updates

More than 40 of these plugins can be

= 250U ML o0 090 Btesse

. . . o
applied or were specifically designed * 15000 Wt Lo e 020 Sz Oct-o6
: + 1.29.08 HAB Frrer Upsdsle (added supssorted fie fom]
for S&T studies. [
It has been downloaded more than R L e 202 Getnvalved
. A + 1.22.08 Merwr Tudorinks "
19,000 times since DCC. 2006. + 1 3208 AR Basic Tutoriat Gotting Stnted S S

Herr I, Bruce W., Huang, Weixia (Bonnie), Penumarthy, Shashikant & Birner, Katy. (2007). Designing Highly Flexible and Usable
Cyberinfrastructures for Convergence. In Bainbridge, William S. & Roco, Mihail C. (Eds.), Progress in Convergence - Technologies for Human

Wellbeing (Vol. 1093, pp. 161-179), Annals of the New York Academy of Sciences, Boston, NLA.

Project Details

Investigators: Katy Borner, Albert-Laszlo Barabasi, Santiago Schnell,
Alessandro Vespignani & Stanley Wasserman, Eric Wernert

Software Team: Lead: Micah Linnemeier "

Members: Patrick Phillips, Russell Duhon, Tim Kelley & Ann McCranie

Previous Developers: Weixia (Bonnie) Huang, Bruce Herr, Heng Zhang,
Duygu Balcan, Mark Price, Ben Markines, Santo Fortunato, Felix
T

Goal: Develop a large-scale network analysis, modeling and visualization toolkit

for physics, biomedical, and social science research.
Amount: $1,120,926, NSF 11S-0513650 award
Duration: Sept. 2005 - Aug. 2009
Website: http://nwb.slis.indiana.edu

Network Workbench (http://nwb.slis.indiana.edu). 8




Personal Bibliographies
» Bibtex (.bib)

» Endnote Export Format (.enw)

Data Providers

» Web of Science by Thomson Scientific/Reuters (.isi)

» Scopus by Elsevier (.scopus)

» Google Scholar (access via Publish or Perish save as CSV,

Bibtex, EndNote)

» Awards Search by National Science Foundation (.nsf)

Scholarly Database (all text files are saved as .csv)

Health (NIH)
Foundation (NSF)

Office (USPTO)

YV V Y VYV

Medline publications by National Library of Medicine
NIH funding awards by the National Institutes of

NSF funding awards by the National Science
U.S. patents by the United States Patent and Trademark

Medline papers — NIH Funding

NWB Tool: Supported Data Formats

Network Formats

» NWB (.nwb)

> Pajek (.net)

»  GraphML (xml or
.graphml)

» XGMML (.xml)

Burst Analysis Format
» Burst (.burst)

Other Formats
CSV (.csv)
Edgelist (.edge)
Pajek (.mat)
TreeML (.xml)

YV VY

NWB Tool: Algorithms (July 1st, 2008)

See https:

Preprocessing IEN

Remove Nodes

Extract Top Nodes

Extract Nodes Above or Below Val

Delete High Degree Modes

Delete Random Nodes

Delete Isolates
Remove Edges

Extract Top Edges

Extract Edages Above or Below Val

Remaove Self Loops

Trim By Degree1

Pathfinder Network Scaling
Sampling

Snowball Sampling (n nodes)

Node Sampling

Edge Sampling
Transformations

Symmetrize

Dichotomnize

Multipartite Joining

Modeling IE1N
General
Random Graph
Watts-Strogatz Small World
Barabasi-Albert Scale-Free
Structured
CAN
Chord
Unstructured
Hypergrid
PRU
Other
TARL
Discrete Network Dynamics

Analysis IEN

General Purpose
Network Analysis Toalkit?
Unweighted & Undirected
Based on degree/
Node Degree
Node Distribution
Based on clustering
k-Mearest Meighbor
Watts Strogatz Clustering Coefficle
Watts Strogatz Clustering Coefficle
Based on path
Diameter
Average Shortest Path
Shortest Path Distribution
Node Betweenness Centrality
Based on components
Connected Components
Weak Component Clustering
K-Core
Extract K-Corel
Annotate K-Coreness?
Unweighted & Directed
Based on degree
Node Indegree
Node Qutdegree
Indegree Distribution
Outdegree Distribution
Based on local graph structure
k-Mearest Meighbor
Single Mode In-Out Degree Correla
Unnamed Category?
Fage Rank
Based on local graph structure
Dyad Recugrocig);_l
Arc Reciprocigg_l
Adiacency Transitivity?
Based on components

nwh.slis.indiana.edu/community and handout for details.

Visualization |IE

GnuPlot?
Predefined Positions Layout
DrL (WxOrd)
Pre-defined Positions (prefuse beta)?
Move
Circular
Tree Layouts
Radial Tree (prefuse alpha)
Radial Tree with Annotations (prefuse betall
Tree Map
Tree View
Balloon Graph (prefuse aloha)?
Network Layouts
Force Directed with Annotation {prefuse beta)
Kamada-Kawai (JUNG)
Fruchterman-Reingold (JUNG)
Fruchterman-Reingold with Annotation (prefuse beta)
Spring (JUNG
Small World {prefuse alphal
Other Layouts
Parallel Coordinates ;dem013
LaMet (k-Core Decomposition)

Scientometrics

Extract Network From Table
Extract Co-Authorship Network
Extract Co-Occurrence Network From Table?
Extract Directed Network From Table?
Extract Network From Another Network
Extract Biblioaraphic Coupling Similarity Network
Extract Co-Citation Similarity NetworkZ
Cleaning
Remove IS Duplicate Records
Detect Duplicate Nodes
Remove Rows With Multitudinous Fields?




. j NWB Tool: Output Formats
w"%'ﬂ‘&

&,

NWB tool can be used for data conversion. Supported output formats comprise:

» CSV (.csv)
Medline Co-authorship Network 1
> NWB (nWb) Largest Component d a3
» Pajek (.net) WX [ y
» Pajek (.mat) S % 1 '
» GraphML (.xml or .graphml) CYIRETE .
> XGMML (xml) o @ARE TR 1 e I
E R
GUESS K W
- . L [ W »zj
» Supports export of images into o0l NVane o
common image file formats. B I
b, e @Zhu,Scngﬁu;l ‘
Horizontal Bar Graphs BideSELand Ay . @ bitans -
> f 1 Betweenness Centrality > ¥ : .
saves out raster and ps files. ® 5o I : SRR
® 2091780 4 f" %
4,781 v
= :

% o j Exemplary Analyses and Visualizations

i

Individual Level

A. Loading ISI files of major network science researchers, extracting, analyzing

and visualizing paper-citation networks and co-author networks.

B. Loading NSF datasets with currently active NSF funding for 3 researchers at

Indiana U

Institution Level

C. Indiana U, Cornell U, and Michigan U, extracting, and comparing Co-PI
networks.

Scientific Field Level

D. Extracting co-author networks, patent-citation networks, and detecting
bursts in SDB data.




Individual Level

Exemplary Analyses and Visualizations

A. Loading ISI files of major network science researchers, extracting, analyzing
and visualizing paper-citation networks and co-author networks.

B.

Download all papers by

» Eugene Garfield

» Stanley Wasserman

» Alessandro Vespignani

> Albert-Laszlé Barabasi

from

» Science Citation Index
Expanded (SCI-EXPANDED)
--1955-present

» Social Sciences Citation Index

(SSCI)--1956-present

» Arts & Humanities Citation
Index (A&HCI)--1975-present

|| AUTHOR: U Enter cne or more author names (see guthar nges 5.

s Be [& Yew Go fockmaks Jods Wndow Hep

9000
o B s B ecaon O Sawrh S
‘cl) M T | % 151 Wb of nowlsdge [+3.0]

15| Web of Knowledge™ @ EJ
Web of Science®

Bwncows| | 7 wur] [ e [ 28| 00 s

General Search AT TH MY START PG |

Select database(s) and Umespan: | meames « |

Citation Databases:

i Scionce Citation Index Expanded (SCI-EXPANDED)--1955-present
¥ U Social Sciences Citation Index (SSC1)-=1958=present

P Arts & Humarstes Citation Trdas (ARHCT)--1975-presant

© Latest [1 waah =] (updated Docomber 09, 2007}
r vear [Zoor =1

@ Erom  [Tess 2] to [Fnor =] (default is all years)

To remember these settings, first S0 n or requter.

Enter terms ar phrases separated by the operators AND, OR, NOT, or SAME, and then press SEARCH. Vigw gur General Search tutanal
The search wil be added to the search history. [22 Yiw your search bestory/sombine sets]

spunc| (s
TOPIC: ) Enter ane or mons terms. Searchas within articls titles, keywords, and absiracts,

Exampio: cil spll* AND "North Sea® (How te search for phrases)
I Tibla ordy

Exanpe; CBRIAN C* OF OBAIAN ©

Author Finder: Need help finding papers by an auther? Use Author Findar,

GROUP AUTHOR: §; Entar ona or more group names (s8e graun authar indes ©),
Exarmpie: CEAN

BOURGE TITLE: ) Entor ful joumnal tthes {soe full source tithes list ),
Exampie: Cancer® OF Journal of Cancer Research and Chinical Oncology

PURBLICATION YEAR: { Fntsr 3 pusileation yasr o rangs.
Frarnple: 3001 ar 1637-18958

ADDRERR: i Enter anbroviatnd terms fram an authors affiiaton (use shbreviations heln).
ampke: ¥ale Univ SAME hasp

Mestrict search by languages and document types:

Frglieh Aticia.
afnkaany Abrtract of Publabad Tham

SRAND

e




E . ; Comparison of Counts
% il&ﬂl}"} No books and other non-WoS publications are covered.

Age Total # Cites Total # Papers H-Index

Eugene Garfield 82 1,525 672 31
Stanley Wasserman 122 35 17
Alessandro Vespignani 42 451 101 33
Albert-1.4sz16 Barabasi 40 2,218 126 47 (Dec 2007)
41 16,920 159 52 (Dec 2008)
E . 3 Extract Co-Author Network
>

Load*yournwbdirectory*/ sampledata/ scientometrics/ isi/ FourNetS ciResearchers.isi’

using 'File > Load and Clean IS1 File'.

To extract the co-author network, select the 367 Unigue IST Records’ table and run
‘Scientometrics > Extract Co-Author Network’ using isi file format:

Il Extract Co-Author Ne |

Extracts a co-authorship network from one of several supparted File
tvpes.

File Format isi [ 1€
Cancell

The result is an undirected network of co-authors in the Data Manager. It has 247
nodes and 891 edges.

To view the complete network, select the network and run ‘Visualization >
GUESS > GEM’. Run Seript > Run Script... . And select Script folder > GUESS >

co-author-my.p).




Alessandro Vespignani Albert-Laszl6 Barabasi

o N\ N ] 7 Node Size & Color
= |/ Number of Papers
127 3

Eug; Garfield




O Paper-Citation Network Layout

Load “*yournmwbdirectory*/ sampledata/ scientometrics/ isi) FourNetS ciResearchers.isi’ using

'"File > 1 .oad and Clean 1S1 File'.

To extract the paper-citation network, select the 367 Unigue 151 Records’ table and run
"Scientometrics > Extract Directed Network' using the parameters:

Il Extract Directed Network x|

Given a table, this algorithm creates a directed network by placing a
directed edge between the values in a given column ko the values of a
different colurnn,

Source Column ICited References j =
Target Colurnn ICite Me As j 9]
Text Delimiter | | 2/
Aggregate Function File | CiiDocuments and SettingsikatyiDeskiopinwbsampledat aiscientometrics\propertiestisiPaper Citation, properties .

oK | Cancel |

The result is a directed network of paper citations in the Data Manager. It has 5,335
nodes and 9,595 edges.

To view the complete network, select the network and run ‘Visualization > GUESS”.
Run “Seript > Run Script ..." and select yournwbdirectory*/ script/ GUESS [ paper-citation-nw.py’.




Individual Level
A.

Exemplary Analyses and Visualizations

B. Loading NSF datasets with currently active NSF funding for 3 researchers at

Indiana U

¥INSF - Award Search - Awardee Information - Mozilla Firefox

Fil

NSF Awards Search via http://www.nsf.gov/awardsearch

Edt View History Bookmerks Took Help

History Bookmarks  Tools  Help

I8 INSF - Award Search - Awardee Information - Mozilla Firefox

Fle  Edit Wiew

-:——-Ev C X @ Iﬁﬁ|http:n'www‘nsf.qow’awardsearchp’index‘js; P IV‘Google ‘3' I~ C X 4 Iﬁ@‘http:fﬂwww.nsf‘gov,iawardsearchfpisaarch 7o I

| Google

Most visited 4 Gatting Started |5\ | Latest Headlines | ‘| Hotel Konigshof - Bod

Most Visted 4 Gerting Started |5\ | Latest Headines | | Hatel Konigshof - Bod

Awardee Information

4

Award Search send Comments | Award Search Help

Program Information Search All Free-Text

Hint: The text field below 'Search Award For' searches the title, abstract, and award numb

Search Award For: |

Restrict to Title Only: [~

A awardee Information

Principal Investigator

First Name: geofirey

Last Name: [tose PI Lookup
Hint: Including CO-PI will result in slower searches.

Include CO-PI: 2

Organization: Organization Looku)

9100833

9014995

G321679

300464

GE04528

B719502

B700064

State: I
2IP Code:

Country: | ;I

Hint: Historical data is from prior to 1976. This data may not be as complete as recent dat

Historical Awards: [
Active Awards Only: [

Expired Awards Only: [

Search Reset

86510451

7819718

e 1o i s ey
Research in Computer Ela

Science and
CormputationalPhysics
Applications of Parallel
Supercomputing to
Astrophysical N-body _
Caloulstions

CISE Research
Instrurnentation for a
Prograrn in Physical
Corputation & Complex
Systemns

REU Site: To Continue an
REU Site in Comnputer snd
Information Science and
Engineering at Caltech
Proposal to Continue an
REU Site in Computer And
InformationScignce And =
Engineering

& Pilot Project in

2

m
=

o
T

0
]

PROGRAMS

ADWANCED COMP
RESEARCH PROGRAM

CISE RESEARCH
RESOURCES

CROSS-DIRECTORATE

PROGRAMS

CROSS-DIRECTORATE

PROGRAMS

CEOSS-OIBECTORLTE

06,/01/1991

0870171990

04/01/1990

05/01/1989

06/01/1988

Perf

Enhanced Supercomputer
Access Facility at the
California Institute of e
Technology

Travel to Attend: 19th
International Conference
on High Energy Physics;

2

o
T
=

Tokyo, Japan; August
23-31, 1978

Save in CSV format as *name*.nsf

WENEDENGINEERTIG

LOCAL ACCESS

INTERMATIONAL TNFO
& ANALYSIS

0971571985

08/23/1978

Fox

Fax

Export nptinns(.ﬂ csy Ik Excel 1€ ®ML

<

|

| one

|| Bt fowen.rsf . qors faw ardsearch/pisearch, do?PIFrstName=geoffrey@P I ountry=aSearch=SearchiP Zip=ao- 49653




E : NSF Awards Search Results
h TN

Name # Awards First A. Starts  Total Amount to Date
Geoffrey Fox 27 Aug 1978 12,196,260

Michael McRobbie 8 July 1997 19,611,178

Beth Plale 10 Aug 2005 7,224,522
Disclaimer:

Only NSF funding, no funding in which they were senior personnel, only as good as NSE’s internal
record keeping and unique person ID. If there are ‘collaborative’ awards then only their portion of the
project (award) will be included.

- : Using NWB to Extract Co-PI Networks
' 'i?._u_ g

A\

Load into NWB, open file to count records, compute total award amount.

Y

Run “Scientometrics > Extract Co-Occurrence Networf® using parameters:
zl

Extracts a network from a delimited table

Column Mame IAI\ Investigatars j \_5,/

Text Delimiter | I \_5,/

Aggregation Function File I C:\Documents and Settingstkaty|Deskioplnwb-scipolicy|sampledata\sdentometrics\properties\nsFCaP L properties Browse \J/

» Select “Extracted Network ..” and ran ‘Analysis > Network Analysis Toolkit
(NAT)’

Remove unconnected nodes via ‘Preprocessing > Delete Isolates’.
Visualization > GUESS’ , layout with GEM

» Run ‘co-PI-nw.py’ GUESS script to colot/size code.

Y VY
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File Edit Layout Script  Wiew Help
Geoffrey Fox N
E Field | alue a
g awards 26
B colaor 0,255,0,255
‘g expirationdate July 31, 2000
£ Fived False Alexandar Ramirez
Z height 50.0
—limage
indearee iz}
label Geoffrey Fox
labelcolor black
labelsize 12 ew Lumsdaine
labelvisible true
name no . Randall Bramiay
autdegree 24
startdate December 1, 1998 2 vid Wise
strokecolor cadethlus *. ————'—'_'_/_. Ryan Mitchel
: » —
totalawardmoney 10806925 Matthew Shepherd
totaldegree G4
sl trus rn Fox @ A Alan Middiston
width 50.0
x 71.3254972250607
Yy 68.8787192001 7658 Lhsan
* & Rith small I
\ Si Catterall
Cqne imon Catteral
i ojtek Furt Gianfranco Vidali
-
== background = white
== resizelinear{coinvestigatedawards, 1, 3}
== for nin gnodes:
nlabelcolor = black
>33
[ Interpreter / Graph Modifier }’
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phen SI mms
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=
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I
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Geoffrey Fox Last Expiration date

W omm e P B0 e 1M s e e

July 10
Michael McRobbie
T e e
-
Feb 10
Beth Plale
. _____________________________________________________________________|
X
;-?u"m.w,mi dal, Pl Seriph fer a0 herivontal in Sept 09

et [

Start Date [START_DATE

EndDate |EFIRATION DATE

Led L Le
LD D s

E=CL N v/ A 0ED AMOUNT T DATE

» ; Exemplary Analyses and Visualizations

Institution Level

C. Indiana U, Cornell U, and Michigan U, extracting, and comparing Co-PI

networks.




NSF Awards Search via http://www.nsf.gov/awardsearch

/2 NSF - Award Search - Search Al Fields - Windows Internet Explorer {2 NSF - Award Search - Search All Fields - Windows Internet Explarer

@T:u [ hetpfwaw.nsf gov/awardsearchy

j | X ILiveSearcr@Tjjv II httpe v nsf . govfawardsearch)

=l 42l ] fuive searcn

File

Edt Wew Favortes Tools Help

Edt  VWew

Favortes  Tools  Help

@ Comvert + [0 Select

W gg'.

i Comvert - [ Select

WSF - Award Search - Se... X | C hitp o0 |

J(":-*-\ii

HOME | FUNDING | AWARDS | DISCOVERIES | NEWS | PUBLICATIONS | STATISTICS
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0 National Science Foundartion

WHERE DISCOVERIES BEGIN
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Award Search Send &1
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Search All Fields . |_

Hint: The text field below 'Search Award For' searches the title, abstract, and award number fields,

Search Award For: |

Restrict to Title Only: [

/2 Awardee Information

Principal Investigator

First Name:

—
——

Hint: Including CO-PI will result in slower searches,

Last Name:

Include CO-PT:

Organization: [university of Michigan Ann Arbor
State:

ZIP Code:

Country: [ =l

Historical Awards: m

Active Awards Only:  [#

Expired Awards Only: [

Search |

Search Results

Back

Results are sorted by award date, with the most recent awards at the top. Click on a column heading to re-sort the results

The up/dewn srrows t the right of s2ch column titls centrol whethsr the sort is sscanding or descending.

To view the abstract, click on the award number or title. Click on the data in other celumns to perform 2 new szarch with tf

Refine Search

619 awards found, dis
[First/Prev] 1, 2, 3, 4|

Award

Number

0820609

0817369

0822892

0825735

0825789

0855898 "

Title

Physial

Helping

Save in CSV format as *nstitution™*.nsf

Teaching T

Knowledge for Teaching (K-
8): Adapting Local Materizls
for Use in Diverse
Institutions and Settings
Protest Psychesis: Race,
Science, and the Stigma of
Schizophrenia

Collaborstive Research:
Tissue Cutting Mechanics -
Invectigation of the Effective
and Minimally Invasive
Biopsy

IMP! NTING THE
XM ORKSHOP
RECOMMENDATIONS

Short-Term Joint
Maintenance and Production
Decision Support Tool of
Manufacturing Systems
Support for the 6th U.S.

o
=
Im

CCLI-Phase 2 [Expansien],

S-STEM:SCHLR SCITECH 01/01/2009 Bazss Hyma|
ENGEMATH

W 01/01/2009  Metzl, Jonat|
2l 01/01/2009  Shih, Alber
CONTROL SYSTEMS 01/01/2009 Ulsoy, A Ga

MANFG ENTERPRISE

SVSTEMS 01/01/2009

COMBUSTION, FIRE, &

I
[T @t

[T @mene

Active NSF Awards on 11/07/2008:
» Indiana University

University-Purdne University School of Medicine)
» Cornell University

University of Michigan Medical S chool)

Save files as csv but rename into .nsf.

257

(there is also Indiana University at South Bend Indiana University Foundation, Indiana University Northwest, Indiana
University-Purdue University at Fort Wayne, Indiana University-Purdue University at Indianapolis, Indiana

501
(there is also Cornell University — State, Joan and Sanford 1. Weill Medical College of Cornell University)

» University of Michigan Ann Arbor
(there is also University of Michigan Central Office, University of Michigan Dearborn, University of Michigan Flint,

619

Or simply use the files saved in “yournwbdirectory*/ sampledata/ scientometrics/ nsf/ .




Extracting Co-PI Networks
Load NSF data, selecting the loaded dataset in the Data Manager window, run
Scientometrics > Exctract Co-Occurrence Network’ using parameters:

Il Extract Network from Table x|

Extracts a network from a delimited table

Column Mame |l Investigators =

Text Delimiter [1 3

Aggregation Function File | C:\Documents and Settings|katy|Desktop\nwblsampledatalscientometrics\properties\nsfCoP1 properties &'Dwss \.7,1
OK I Cancel

Two derived files will appear in the Data Manager window: the co-PI network and a
merge table. In the network, nodes represent investigators and edges denote their co-
PI relationships. The merge table can be used to further clean PI names.

Running the ‘Analysis > Network Analysis Toolkit (NAT)’ reveals that the number of
nodes and edges but also of isolate nodes that can be removed running Preprocessing >
Delete Isolates’.

Select ‘Visnalization > GUESS’ to visualize. Run ‘co-PI-nw.py’ script.
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Extract Giant Component

Select network after removing isolates and run ‘Analysis >
Unweighted and Undirected > Weak Component Clustering’ with parameter
x|

Creates new graphs containing the top connected components.

&

Cancel |

Murnber of top clusters | 10

Indiana’s largest component has 19 nodes, Cornell’s has 67 nodes,
Michigan’s has 55 nodes.

Visualize Cornell network in GUESS using same .py script and save
via File > Export Image’ as |pg.

o
ﬁfﬂ-‘ Thom

Reter Wittich

A’L/b
Gibbons
Trivellore Raghtnathan
J( éﬁésn% Johannes Gehrke
Walkdé® \White

qnald Jger John Abov
% dan Deme /
p ames Cordes
@*’“ er

liel Huttenlocher

IA
&

E £ Mark Ratner
ric Fried S Lavi
%, W James Setfina

= T
EvaTd ang andice -l' v asi
\ j, phen Raeul Chew

Rayl Ramaknsh John Guckenheime
Heenneth Brown
‘ "'_-_“-___-
Wﬂv"‘ Edward Swartz

X Richard Durrett
Node size/color ~ totalawardmoney 4& ® cniip Protter
Top-50 totalawardmoney nodes are labeled. ""

Sidnev Resnick

flliam Welch

‘ Roger Cappallo
Q Idsmith

Sander Weinreb

Stephen Roehrig

offrej Coates

Daniel Ralph
Abruna

sseph Halpern

DavidgStrahd

lkeshav F
Largest component of
Cornell U co-PI network

Gennady Samorodnitsky




Top-10 Investigators by Total Award Money

for i in range(0, 10):

print str(nodesbytotalawardmoney(i].label) + ": "' +
str(nodesbytotalawardmoneyli].totalawardmoney)

Indiana University

Curtis Lively: 7,436,828
Frank Lester: 6,402,330
Maynard Thompson: 6,402,330
Michael Lynch: 6,361,796
Craig Stewart: 6,216,352
William Snow: 5,434,796
Douglas V. Houweling: 5,068,122
James Williams: 5,068,122
Miriam Zolan: 5,000,627
Carla Caceres: 5,000,627

Cornell University

Maury Tigner: 107,216,976
Sandip Tiwari: 72,094,578
Sol Gruner: 48,469,991
Donald Bilderback: 47,360,053
Ernest Fontes: 29,380,053
Hasan Padamsee: 18,292,000
Melissa Hines: 13,099,545

Daniel Huttenlocher: 7,614,326
Timothy Fahey: 7,223,112
Jon Kleinberg: 7,165,507

Michigan University

Khalil Najafi: 32,541,158
Kensall Wise: 32,164,404
Jacquelynne Eccles: 25,890,711
Georg Raithel: 23,832,421

Roseanne Sension: 23,812,921
Theodore Norris:  23,35,0921
Paul Berman: 23,350,921
Roberto Metlin: 23,350,921
Robert Schoeni: 21,991,140
Wei-Jun Jean Yeung:21,991,140

Scientific Field Level

; Exemplary Analyses and Visualizations

D. Extracting co-author networks, patent-citation networks, and detecting

bursts in SDB data.




SCHOLARLY DATABASE

Cyberinfrastructure for Network Science Center, SLIS, Indiana University, Bloomington

P 3R
-ha',‘

H T H f T T T T T T T
] | ] 1 1 | i i . i ]
Search | Edit Profile | About | Logout| Search | EditProfile | About | Logout | Search : Edit Profile | Admin : About '
Search Browse Results Download Results
Creators: I [ SelectAll S Seme e o
s I— Your search raturmad 13,225 results in 0.162 seconds. Medline Database:
) ) Medline master table ™ %
Abstract: I Total results per databsse: NIH: 2,103, Medline: 10,229, USPTO: 279, NSF: 614, M Medline author table ™ 9
all Text:  [artficial intellgence” e iy e EN
First vear: [1698 7] Rmsclir 1 Samugh 20: # Medline co-author table (nwb format) ™ '
Next>>
Last Year: IEDEIB vi NIH Database:
Source  Authors [Creators Year Title (1 NIH master table ™ 5
F siedine (1898 - z008)
P win (1961 - 2002) Medline LaCombe 1987 Artificial intelligence. NSF Database:
sk (1985 - zoa4) Medline 1989 Artificial intelligence: expert systems. 1 NSF master table ™ 2
F usero 1976 - 2008) Madling  Schmitt 1990 [Artificial intelligence in dentistry | & NSF co-imvestigator table Gawh format) B2 B
) . Madline ﬁ::::::: ard 2002 Artificial —_— v m
 Search .

Medline Co-authorship Network
Largest Component ! $

Node Size and Color by
Betweenness Centrality

® 58770
® 2,001,780

4,781 !




Patent Citation Network
Largest Component

Degres for o7110983: 545 '
Methods for matching, selecting, narrowcasting, and,‘or classifying...
Degree for 07092914 539

Methods for matching, selecting, narrowcasting, and,‘or classifying...
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Degree for 061121819: 312 ® 312
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Degree for 07403922: 185 . B °
Method and for frand risk inan - . chted patemt citing Faent
Degree for 074336852: 107 W

Runtime program regression analpsis tool for a simulation engine

Top-10 burst termg from abgtracts of the AT search results.

Mediine NIH

Word Tength | Weight | Start | End Word Length | Weight Start | End
medical 17 | 2987924 | 1983 1959 Fhase B | 117.2205 1953 | 2000
knowledge 5| 2939375 1591 1955 commercial 9| 87.57158 1595
fmowledge & | 215.2407 | 1997 200z proposed 9| 8757158 1555

expent 13 | 171.0443 | 1985 1957 mass 3| 83.36952 1578 | 1980
eystems 15 | 170.3306 | 1985 1959 protein 1| 7215788 1588 | 1938
intelligence 21 | 1239794 | 1981 2001 networks 4| 71252 1993 | 1996
patient 21 | 1239297 | 1982 2002 patterns 3 | 66.44826 1977 | 1979
care 12 | 1065522 | 1930 2001 bring 8 | 66.292%4 1971 | 1978
registration 5 1048139 2005 reasoning 2| 6568178 1984 | 1985
Imowledge-based 16 | 98.83778 | 1987 200z pE—— 7| 6045935 1587 | 1990
NSF USPTO

Word Length Weight Start End Word Length Weight Start | End
theit 6| 47.05097 | 1999 human 3| 19.03937321 | 2004 | 2006
gray 2| 2813808 | 2000 2ol video 3 | 1532736425 | 1998 | 2000
learning 2| 2740728 | 1997 1998 disclosed 2 | 14.06694671 | 1999 | 2000
human 3| 234525 ] 2000 neural 3 | 13.30105006 | 2004 | 2006
control 2| 2407877 | 1802 1993 "comrect” 2| 124336047 | 1999 | 2000
Tnowledge 1| 2148756 | 1998 1998 it o | 12 35725838 | 2002 | 2003
students 1| 2Lo7674 | 1997 1997 o aperia] 1 1 12 03227035 | 2000 | 2000
problems 2| 2097133 | 1998 1999 feedback 1| 1207730195 | 2000 | 2000
more 2| 1956109 | 2000 2001 rule 1| 12.07730195 | 2000 | 2000
use 1] 1938503 | 2001 2001 slevator 4| 1183351857 | 1991 | 1994




PORTAL

Provided by the Cyvberinfrastructure for Network Science Center at Indiana University.

Introduction
E. 0. Wilson writes in Consflience: The Unity of Knowledge (1998): “Features that distinguish science from
pseudoscience are r bility, economy, mens , heuristics, and consilience.”

Flease see Borner's recent presentation at the A Deeper Look af the Visualization of Scientific Discovery NSE
Workshop for a general introduction of the needs and the resources provided here.

Needs Analysis

As part of the “TLS: Towards a Macroscope for Science Policy Decision Making” NSF SBE-0738111
award, interviews with science policy makers are conducted to identify what science of science’ research
results and tools might be most desirable and effective. So far, 30 formal, one-hour interviews have been
conducted with science policy makers at university campus level, program officer level, and division
director level for zovernmental, state, and private foundations. Data compilation will start in October
2008 and resulting report can be ordered by sending a request to Mark Price (maaprice@indiana.edu).

Conceptualization of Science

A ‘science of science’ requires a theoretically grounded and practically useful conceptualization of the
structure and evolution of science. A special journal issue entitled “Science of Science:
Conceptualizations and Models of Science” edited by Katy Bérner, Indiana University & Andrea
Scharnhorst, Royal Netherlands Academy of Arts and Sciences invites contributions on this topic. It will
be published in the Journal of Informetries 3(1) in January 2009.

Scholarly Database

The Scholarly Database (SDB) at Indiana University aims to serve researchers and practitioners
interested in the analysis, medeling, and visualization of large-scale schelarly datasets. The database
currently provides access te over 20 million papers, patents and grants. Resulting datasets can be
downloaded in bulk. Register for free access at https://sdb.slis.indiana.edu/.

Cyberinfrastructures

The Scientometrics filling of the Network Workbench (NWE) Tool provides a unique distributed, shared
resources environment for larze-scale network anal modeling, and visualization. Thomson
Scientific/IS1, Scopus and Google Scholar data, EndNote and Bibtex files, or NSF awards can be read and
diverse networks can be extracted and studied. Download User Manual with focus on Scientometrics.

http://sci.slis.indiana.edu

Mapping Science Exhibit — 10 Iterations in 10 years
bttp:/ [ scimaps.org

The Power of Maps (2005)

Science Maps for Science Policy Makers (2009)
Science Maps for Scholars (2010)

Science Maps as Visual Interfaces to Digital Libraries (2011)
Science Maps for Kids (2012)

Science Forecasts (2013)

How to Lie with Science Maps (2014)

Exhibit has been shown in 52 venues on four continents. Also at

- NSE, 10th Floor, 4201 Wilson Boulevard, Arlington, VA.

- Chinese Academy of Sciences, China, May 17-Now. 15, 2008.

- University of Alberta, Edmonton, Canada, Nov 10-Jan 31, 2009

- Center of Advanced European Studies and Research, Bonn, Germany,
Dec. 11-19, 2008.




Debut of 5% Iteration of Mapping Science Exhibit at MEDIA X on May 18, 2009
at Wallenberg Hall, Stanford University

Science Maps in “Expedition Zukunft” science train visiting 62 cities in 7 months

12 coaches, 300 m long
Opened on April 23, 2009 by German Chancellor Merkel
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cyberinfrastructure for
ETWORK SCIENCE CENTER

School of Library and Information Science | Indiana University Bloomington

Cyberinfrastructures

All papers, maps, cyberinfrastructures, talks, press are linked
from http://cns.slis.indiana.edu




